Current Biology 22, 1500–1505, August 21, 2012 ª2012 Elsevier Ltd All rights reserved

http://dx.doi.org/10.1016/j.cub.2012.06.025

Tropomodulin Protects a-Catenin-Dependent
Junctional-Actin Networks under Stress
during Epithelial Morphogenesis
Elisabeth A. Cox-Paulson,1 Elise Walck-Shannon,2
Allison M. Lynch,3 Sawako Yamashiro,4,5
Ronen Zaidel-Bar,3,6 Celeste C. Eno,2 Shoichiro Ono,4
and Jeff Hardin2,3,*
1Department of Biology, State University of New York at
Geneseo, 353 Integrated Science Center, 1 College Circle,
Geneseo, NY 14454, USA
2Program in Genetics, University of Wisconsin–Madison,
1117 W. Johnson Street, Madison, WI 53706, USA
3Department of Zoology, University of Wisconsin–Madison,
1117 W. Johnson Street, Madison, WI 53706, USA
4Department of Pathology, Emory University, Whitehead
Research Building, Room 105N, Atlanta, GA 30322, USA

Summary
a-catenin is central to recruitment of actin networks to the
cadherin-catenin complex [1, 2], but how such networks are
subsequently stabilized against stress applied during
morphogenesis is poorly understood. To identify proteins
that functionally interact with a-catenin in this process, we
performed enhancer screening using a weak allele of the
C. elegans a-catenin, hmp-1, thereby identifying UNC-94/
tropomodulin. Tropomodulins (Tmods) cap the minus ends
of F-actin in sarcomeres [3]. They also regulate lamellipodia
[4], can promote actin nucleation [5], and are required for
normal cardiovascular development [6, 7] and neuronal
growth-cone morphology [8]. Tmods regulate the morphology of cultured epithelial cells [9], but their role in
epithelia in vivo remains unexplored. We find that UNC-94
is enriched within a HMP-1-dependent junctional-actin
network at epidermal adherens junctions subject to stress
during morphogenesis. Loss of UNC-94 leads to discontinuity
of this network, and high-speed filming of hmp-1(fe4);unc94(RNAi) embryos reveals large junctional displacements
that depend on the Rho pathway. In vitro, UNC-94 acts in combination with HMP-1, leading to longer actin bundles than with
HMP-1 alone. Our data suggest that Tmods protect actin filaments recruited by a-catenin from minus-end subunit loss,
enabling them to withstand the stresses of morphogenesis.
Results and Discussion
C. elegans epidermal morphogenesis provides an excellent
context in which to investigate the relationship between actin
and a-catenin in vivo. The embryonic epidermis contains three
types of cells: (1) dorsal cells, which eventually fuse into
a syncytium; (2) lateral (seam) cells, arranged in a single row
along the anterior-posterior axis on each side of the embryo;
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and (3) ventral cells. A conserved cadherin-catenin complex
(CCC), including HMR-1/cadherin, HMP-2/b-catenin, HMP-1/
a-catenin, and JAC-1/p120-catenin [10, 11], is crucial for
epidermal morphogenesis [12, 13]. Actomyosin-mediated
contractile stresses are transmitted by circumferential actin
filament bundles (CFBs) in dorsal and ventral epidermal cells.
CFBs insert orthogonally at junctional boundaries between
lateral epidermal cells and dorsal and ventral epidermal
cells and help to drive the 4-fold elongation of the embryo.
CFB anchorage at adherens junctions (AJs) requires the
CCC [14–16].
Functional interactions between multiple pathways are
important for both focal adhesions and hemidesmosomes
[17, 18]. However, a systematic search for similar functional
interactions has not been carried out for AJs. We performed
such a search, using feeding RNA interference (RNAi) against
genes on chromosome I to find lethal enhancers of a weak
loss-of-function allele of hmp-1, fe4. hmp-1(fe4) mutants
exhibit embryonic and early larval lethality; escapers develop
into fertile adults that have body-shape defects [11]. The fe4
lesion results in an amino-acid substitution in the VH3 domain
of HMP-1 [11], which slightly weakens F-actin binding
(S. Maiden and J.H., unpublished data).
We identified several genes implicated in regulating cell-cell
adhesion, including the AF6/Afadin ortholog (afd-1) and an
exocyst component (sec-8) [19–21], validating our approach.
A full analysis, including results for the other five chromosomes, will be published elsewhere (A.M.L. et al., unpublished
data). Among the enhancers was UNC-94, a tropomodulin
(Tmod) family member.
To examine the functional relationship between HMP-1
and UNC-94, we first performed four-dimensional Nomarski
microscopy on hmp-1(fe4);unc-94(RNAi) embryos (Figure 1A).
Wild-type embryos elongated to approximately 4-fold their
initial length before hatching. unc-94(RNAi) embryos appeared
superficially wild-type, even though unc-94(RNAi) lowered
UNC-94 protein to virtually undetectable levels (Figure S1A
available online). hmp-1(fe4) embryos exhibited defective
elongation (Figure 1A) and approximately 80% died as embryos and L1 larvae (n = 95). hmp-1(fe4) embryos that hatched
typically elongated to only twice their original length and
had severe body-shape defects. In contrast, 100% of hmp1(fe4);unc-94(RNAi) embryos exhibited embryonic lethality
(n = 93). Of these, 95% failed to elongate past the 1.5-fold
stage, and they then retracted to their original body length
(Figure 1A), compared with only 13% of hmp-1(fe4) embryos
(see Movie S1 for movies of representative embryos). Thus,
HMP-1 and UNC-94 together are essential for epidermal
elongation.
Second, we performed immunostaining with an antibody
that we previously used to show that UNC-94 is found at
body wall-muscle cell-cell boundaries and at the minus ends
of sarcomeric thin filaments [22, 23]. UNC-94 was first detectable at the 2-fold stage and was enriched at seam-ventral and
seam-dorsal cell borders, the same borders where CFBs
transmit stress during elongation (Figure 1B; see Figure 1C
for the relationship between CFBs and junctional actin in
a wild-type embryo). Although UNC-94 is near AJs, it is distal
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Figure 1. hmp-1(fe4);unc-94(RNAi) Embryos
Arrest during Embryonic Elongation, and Epidermal UNC-94 Localization to Junctions Requires
hmp-1 Function
(A) Nomarski images of representative embryos undergoing elongation are shown at the
indicated time intervals. Embryos are initially
oriented with the anterior to the left and the
ventral side up at time (T) = 0 hr, and lateral views
are shown for all other time points. T = 0 hr shows
embryos at the completion of enclosure. Wildtype (WT), unc-94(RNAi), hmp-1(fe4), and hmp1(fe4);unc-94(RNAi) embryos are shown. No
obvious defects in elongation are evident in the
unc-94(RNAi) embryo. hmp-1(fe4) embryos
develop mild body-shape defects during elongation. 95% of hmp-1(fe4);unc-94(RNAi) embryos
(n = 93) elongate to the 1.5-fold stage or less, then
retract to their original length. See Movie S1.
(B) Wild-type embryo expressing JAC-1::GFP to
mark AJs and stained with an affinity-purified
rabbit UNC-94 antibody. Seam-ventral (*) and
seam-dorsal (**) cell borders are indicated.
UNC-94 is first detected at epidermal-cell borders
around the 2-fold stage of elongation. The color
merge shows JAC-1::GFP in green and UNC-94
in red. Enlargement of the boxed region shows
UNC-94 staining overlapping JAC-1::GFP.
(C) Wild-type stained with phalloidin. CFBs and
the junctional-actin belt are indicated.
(D) UNC-94 staining in wild-type and hmp-1 mutants. In wild-type elongation-stage embryos, 23% have UNC-94 localization at epidermal-cell borders (n = 79).
In hmp-1(zu278) embryos, 0% have UNC-94 localization at epidermal-cell borders (n = 87). In hmp-1(fe4) embryos, 35% have UNC-94 localization at
epidermal-cell borders (n = 63). Note that this staining was done via freeze-cracking, which is known to disrupt actin but preserves the UNC-94 epitope recognized by UNC-94 antibodies. Disruption of junctional actin caused by this technique may account for the percentage of embryos exhibiting UNC-94 localization at epidermal-cell borders. Bars represent 10 mm.

to them and extends into the cytoplasm, in the same location
as the junctional-actin band that runs parallel to AJs. Consistent with this localization pattern, UNC-94 did not coimmunoprecipitate with HMP-1 under conditions in which HMP-1
and HMP-2 did (Figure S1B). Significantly, UNC-94 did not
localize to epidermal junctions in hmp-1(zu278) homozygotes,
which produce a truncated HMP-1 protein incapable of
binding actin [16] (Figure 1D), indicating that HMP-1’s actinbinding activity is required for mobilization of actin filaments
containing UNC-94 near epidermal-cell borders. In contrast,
UNC-94 largely localized normally to epidermal-cell borders
in hmp-1(fe4) embryos (Figure 1D) and localized in pharyngeal
cells in a HMP-1-independent manner (Figure S1C). Thus,
HMP-1 acts upstream of UNC-94 at epidermal-cell borders
normally under tension, but this functional relationship is not
mediated through direct physical binding.
To better understand why hmp-1(fe4);unc-94(RNAi) embryos fail to elongate, we covisualized AJs and actin
during this process using phalloidin staining and JAC-1/
p120-catenin::GFP. Strikingly, seam-dorsal and seam-ventral
epidermal-cell borders in hmp-1(fe4);unc-94(RNAi) embryos
were highly disrupted, appearing ripped apart and yielding
a characteristic zigzag pattern (Figure 2A). Junctions between
other epidermal cells were no more perturbed than those in
hmp-1(fe4) homozygotes. In areas of perturbed JAC-1::GFP,
only some faint actin filaments were visible. Despite this,
CFBs were still present in hmp-1(fe4);unc-94(RNAi) embryos,
interfacing with the edges of the mislocalized JAC-1::GFP (Figure 2A). The junctional-actin belt was still present but was
more diffuse in hmp-1(fe4);unc-94(RNAi) embryos compared
to hmp-1(fe4) (Figure 2A, black arrows). The perturbed AJs

and actin organization at these epidermal-cell borders in
hmp-1(fe4);unc-94(RNAi) embryos probably account for their
failed elongation.
Immunostaining experiments demonstrated that HMR-1
colocalized with mislocalized JAC-1::GFP in hmp-1(fe4);unc94(RNAi) embryos, indicating that the entire CCC was affected
(Figure 2B, top). In contrast, AJM-1, a component of the
more basal AJM-1/DLG-1 complex, was unaffected in hmp1(fe4);unc-94(RNAi) embryos (Figure 2B, bottom). Thus, UNC94 specifically regulates the CCC and its associated actin.
To better characterize the range of defects in unc-94(tm724)
and unc-94(RNAi) embryos, we scored wild-type and unc-94
loss-of-function embryos stained with phalloidin based on
the extent of F-actin disruption (Figure S2). We found defects
in both junctional actin and CFBs, suggesting that UNC-94
has a role not only in maintaining proper junctional actin, but
also in the anchoring of CFBs to the junctional-actin band.
To examine junctional-proximal actin defects in more detail,
we measured the extent to which junctional actin was contiguous at seam-dorsal and seam-ventral boundaries in wild-type
and unc-94(tm724) embryos using phalloidin staining (Figures 2C and 2D). In wild-type embryos, 73.7 6 2.7% (mean 6
SEM; n = 11 cells) of the junctional perimeter contained signal,
compared with 48.9 6 4.2% in unc-94(tm724) embryos (n = 16
cells; significantly different, p < 0.0002, heteroscedastic t test).
Similarly, the mean length of contiguous regions of actin at
junctions was significantly greater in wild-type embryos
(0.41 6 0.11 mm, n = 11 cells) versus unc-94(tm724) embryos
(0.13 6 0.02 mm, n = 16 cells; significantly different, p < 0.04).
Such defects may have a common cause: defects in the junctional-actin band may affect proper anchoring and/or spacing
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Figure 2. UNC-94 Contributes to AJ Stability
(A) Representative hmp-1(fe4) and hmp1(fe4);unc-94(RNAi) embryos. Embryos are of
similar age (the hmp-1(fe4);unc-94(RNAi) embryo has retracted). Embryos express JAC-1/
p120catenin::GFP and are stained with phalloidin
for visualization of actin. Color merges show
JAC-1::GFP in green and actin in red. In hmp1(fe4);unc-94(RNAi) embryos, JAC-1::GFP is
fragmented and mislocalized at seam-dorsal
and seam-ventral borders. Actin is depleted in
areas of disrupted JAC-1::GFP; however, CFBs
(white arrow) and diffuse junctional actin (black
arrow) are still visible. The anterior is to the left
in all panels. Bar represents 10 mm.
(B) In hmp-1(fe4);unc-94(RNAi) embryos, the
CCC is selectively perturbed. Prearrest hmp1(fe4);unc-94(RNAi) embryos expressing JAC1::GFP were stained for either HMR-1/cadherin
or AJM-1. Color merges show that HMR-1 (red)
colocalizes with JAC-1::GFP (green), and that
AJM-1 is not perturbed in regions where JAC1::GFP is mislocalized. For all images in (A)–(D),
anterior is to the left.
(C) Junctional-proximal actin in representative
wild-type (WT; top) and unc-94(tm724) embryos
(bottom). Regular puncta of actin are connected
along the junction in wild-type embryos, but gaps
are present in junctions from unc-94(tm724)
embryos. Bars represent 10 mm.
(D) Box plots of the total percentage of junctional
area in which actin signal is present (left) and the
average length of contiguous regions of actin
(right). Blue: First quartile; white: third quartile;
pink: mean. The circle represents a mild outlier;
X represents extreme outliers. In wild-type, there
are occasional stretches of long, unbroken
domains of positive signal along entire cells or
multiple cells (X).

of CFBs. Vertebrate Tmod3 may similarly stabilize F-actin at
lateral cell membranes in immortalized epithelial-cell lines [9].
Taken together, these data suggest an important role for
HMP-1 and UNC-94 in regulation of AJs and junctional actin
at cell borders under stress during morphogenesis. Next, we
observed CCC dynamics in living, prearrested embryos in
jac-1::gfp-expressing embryos using high-speed filming
(Figures 3A–3C). In wild-type embryos, JAC-1::GFP was
restricted to the apicolateral contact zones between epidermal
cells (Figure 3A). unc-94(RNAi) and unc-94(tm724) embryos
exhibited JAC-1::GFP dynamics similar to wild-type, though
rarely some mislocalization occured (Figures S3A and S3B).
In hmp-1(fe4) homozygotes, the JAC-1::GFP distribution was
slightly fragmented, and some JAC-1::GFP was transiently
pulled away from the main area of the junction (Figure 3B).
Strong zygotic loss of hmp-1 function in zu278 homozygotes
yielded a similar mild effect (Figure S3C), consistent with
our previous report [24]. In contrast to single mutants,
however, dislocation of JAC-1::GFP was greatly enhanced in
hmp-1(fe4);unc-94(RNAi) embryos (Figure 3C). Reslicing
images through the z axis of these extended regions showed
that they are linear and occur perpendicular to the AJ

(data not shown). Their spacing and
linearity is consistent with them being
caused by pulling forces exerted by
the CFBs. hmp-1(fe4);unc-94(RNAi) embryos formed about twice as many JAC1::GFP extensions (R0.5 mm long) as hmp-1(fe4) embryos
(Figure 3D). Moreover, as demonstrated in Figure 2C, the AJs
of hmp-1(fe4);unc-94(RNAi) embryos became progressively
more disrupted as time goes on, suggesting that applied
stress results in dystrophic disruption of these junctions. Significantly, these regions extended into both seam and ventral
or dorsal epidermal cells, with many more in the latter (Table
S1). Tissue-specific rescue experiments further demonstrated
that although UNC-94 plays a role in both seam cells and nonseam cells, there is a more stringent requirement in nonseam
cells (Figure S4A).
The phenotypes we observed are very similar to those
described previously in rga-2/RhoGAP mutants [25], though
they are less pervasive along the apicobasal axis. We therefore
assessed whether reducing stress on epidermal junctions
could ameliorate the JAC-1::GFP extensions observed in
hmp-1(fe4);unc-94(RNAi) embryos, using RNAi against let502/Rho kinase. hmp-1(fe4);unc-94;let-502(RNAi) embryos
exhibited a significant decrease in the number of JAC-1::GFP
extensions (Figure 3D), and arrested embryos showed less
JAC-1::GFP mislocalization (cf. Figure S3D versus Figure S3E).
This suggests that the AJs in hmp-1(fe4);unc-94(RNAi)
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Figure 3. AJs of hmp-1(fe4);unc-94(RNAi) Embryos
Exhibit Abnormal Dynamics
(A)–(C) Images from spinning-disk confocal movies of
embryos expressing JAC-1::GFP are shown. (a)–(c)
show an enlargement of the boxed regions in (A)–(C)
at 30 s intervals for 5 min. Movie S2 corresponds to
(a)–(c). In wild-type embryos (A), JAC-1::GFP localizes
to epidermal-cell borders; in hmp-1(fe4) embryos (B),
there are occasional areas in which JAC-1::GFP is transiently extended away from its normal position. In hmp1(fe4);unc-94(RNAi) embryos (C), this behavior is more
pronounced. Bar represents 10 mm.
(D) Bar graph showing quantification of the number
(mean 6 SEM; n indicated in parentheses) of JAC1::GFP extensions longer than 5 mm formed at either
the seam-dorsal or seam-ventral cell border during
5 min of filming. Embryos at comma to 1.5-fold stage
were scored. Each extension was measured only
once, at its longest length. Asterisk: significantly different from hmp-1(fe4) and hmp-1(fe4);unc-94(RNAi);let502(RNAi) (Tukey test: p < 0.01). Black diamonds: not
significantly different from hmp-1(fe4) (p > 0.5).

embryos are not able to withstand the stress transmitted by
CFBs during elongation and instead become pulled in the direction of the exerted force. To further investigate the effects of
let-502 loss of function on junctions, we used a temperaturesensitive let-502 mutant to assess whether LET-502 activity
is required for recruitment of UNC-94 to cell borders and
found that this is not the case, although cell elongation along
the anterior-posterior axis is required for compaction of the
zone of UNC-94 expression along seam-nonseam borders
(Figure S4B).
To gain mechanistic insight into how HMP-1 and UNC-94 act
together to modulate actin networks, we performed in vitro
actin-binding and -bundling assays. We showed previously
that UNC-94 alone can inhibit latrunculin A-induced depolymerization of plus end-capped C. elegans F-actin and that
UNC-94 blocks minus-end F-actin depolymerization induced
by UNC-60B/ADF-cofilin [23]. We also showed previously
that full-length HMP-1 alone can cosediment with actin filaments in vitro. This activity appears to be regulated by intramolecular interactions within the full-length protein, given
that the full-length protein cosediments less avidly than
C-terminal fragments [16]. We therefore examined the combined effects of HMP-1 and UNC-94 on actin-filament morphology in vitro using fluorescently labeled actin filaments
capped at the plus ends by CapZ, to which HMP-1, UNC-94,
or both were added (Figure 4A). Added alone, HMP-1 induced
actin bundles, as did other a-catenins [26–28]. However, actin
bundles generated in the presence of both HMP-1 and UNC-94
(n = 603, average length = 6.1 mm 6 2.7 SD) were 42% longer
than those resulting from HMP-1 alone (n = 663, average
length = 4.3 mm 6 2.8; significantly different, p < 0.001,

Figure 4B), and this increase is due in part to
an increase in long bundles (Figure 4B,
bracket). Taken together, these data indicate
that HMP-1 and UNC-94 probably act together
to generate robust actin filaments in the
junctional-actin band, which in turn resist
mechanical deformation due to Rho-mediated
actomyosin contractility.
The actin cytoskeleton and AJs cooperate
to drive numerous epithelial morphogenetic
events [2]. AJs recruit actin via a-catenin;
initial recruitment may be modulated by Arp2/3-mediated actin
branching or by processive plus-end proteins that stimulate
more linear networks [2]. Once actin networks form at AJs,
however, they must withstand stress and resist dissolution.
Our results indicate a new role for Tmod at the minus ends of
actin filaments in this process.
In the embryonic epidermis of C. elegans, UNC-94 is
enriched at a subset of epidermal-cell borders that interface
with CFBs, within the dense network of junctional-actin
bundles that runs lateral to AJs at these cell borders. Our
in vitro analysis indicates that UNC-94 can protect filaments
bundled by HMP-1 from minus-end subunit loss, because
this assay was performed under conditions that favor
depolymerization from the minus end rather than addition of
monomers to plus ends. Because some Tmods promote actin
nucleation [5], a non-mutually exclusive possibility is that
UNC-94 also plays a supporting role in de novo formation of
junctional-actin filaments.
In hmp-1(fe4);unc-94(RNAi) embryos, inefficient actin
recruitment by mutant a-catenin, coupled with minus-end
subunit loss, may lead to a less robust junctional-actin
network, which in turn results in lateral instability of AJs. If
CFBs are mechanically coupled to the junctional-actin band
near their tips (e.g., via actin-crosslinking proteins or through
a-catenin itself), stress will tend to be distributed laterally
throughout the junctional-actin band, reducing stress at
CFB-insertion sites. We envision such reinforcement as functioning in much the same way that the roots of a tree protect
it from being uprooted: by distributing stress laterally. This
idea is supported by our observation that decreasing actomyosin contractility alleviates the junctional displacements
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Figure 4. HMP-1 and UNC-94 Synergistically
Regulate Actin Bundles In Vitro
(A) Images show fluorescently labeled, plus endcapped F-actin (5 mM), to which either HMP-1
(5 mM), UNC-94 (2.5 mM), or both have been
added. Note that actin bundles form only when
HMP-1 is present and that UNC-94 can lengthen
HMP-1-generated actin bundles. Bar represents
10 mm.
(B) (Left) Histogram of actin-bundle length when
HMP-1 is added alone (n = 663) or together with
UNC-94 (n = 603). Percentage of bundles exhibiting particular lengths (indicated in mm) is shown.
The bracket indicates that when HMP-1 and
UNC-94 are added together, there is an increase
in the longest population of bundled filaments.
(Right) Mean length of actin bundles formed
by HMP-1 alone and HMP-1 plus UNC-94. Error
bars represent SEM. Actin bundles generated
by HMP-1 plus UNC-94 are significantly longer
than those generated by HMP-1 alone (p <
0.001, two-tailed t test).

observed in hmp-1(fe4);unc-94(RNAi) embryos. We propose
that the retraction phenotype exhibited by hmp-1(fe4);tmd1(RNAi) embryos (in which the embryos extend to w1.5-fold
and then retract to their original length) may be due to a combination of uneven CFB-pulling forces from abnormally arranged
CFBs and weakened ultrastructure of the junctional-actin
band. This could result in failure to translate the stress applied
by CFBs into the epidermal cell-shape changes that drive
elongation.
Junctional-actin bands are present in many epithelial-cell
types. The forces applied to them can be aligned predominantly along the junction or orthogonal to it, the latter being
the case during C. elegans embryonic elongation (reviewed
in [29]). Our work suggests that regulation of minus-end actin
dynamics via Tmod plays an important role in promoting
stability of actin networks under this orthogonal stress. Future
experiments aimed at teasing apart the ultrastructure and
biochemical regulation of junctional-actin bands should help
to clarify their function, as well as how multiple actin regulators
contribute to the mechanical integrity of AJs.
Supplemental Information
Supplemental Information includes four figures, one table, two movies, and
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Table S1. Number and Directionality of Junctional Extensions in hmp-1(fe4) and hmp1(fe4);unc-94(RNAi) Embryos

# embryos
analyzed

# total
extensions
(>= 0.5 mm)
48
(2.3 / embryo)

# non-seam
directed
extensions
(>= 0.5 mm)
22
(1.0 / embryo)

# seam
directed
extensions
(>= 0.5 mm)
26
(1.2 / embryo)

hmp-1(fe4);
jac-1::gfp

21

hmp-1(fe4);
jac-1::gfp;
unc-94(RNAi)

18

97
(5.4 / embryo)

60
(3.3 / embryo)

37
(2.1 / embryo)

Figure S1. Additional Analysis of HMP-1 and UNC-94 Interactions
A. Western blot showing reduced expression of UNC-94 in unc-94(RNAi) embryos. Lysate from 30 N2 or
N2; unc-94(RNAi) worms was loaded in each lane and probed for either UNC-94 or actin. Western blot
showing reduced expression of UNC-94 in embryos treated with unc-94(RNAi). Lysate from 30 N2 or N2;
unc-94(RNAi) worms was loaded in each lane and probed for either UNC-94 or actin. RNAi was
performed via feeding. B. HMP-1 and UNC-94 do not coimmunoprecipitate. SU265 (hmp-1::gfp; dlg1::dsRed) embryos were collected and extracts collected as described in Experimental Procedures. Extracts
were subjected to immunoprecipitation using anti-GFP antibodies, and the resulting non-precipitated
proteins (input) and immunoprecipitates (IP) were blotted and probed using anti-GFP (αGFP), anti-HMP-2
(αHMP-2), or anti-UNC-94 (αUNC-94) antibodies. Whereas there is robust signal for HMP-1::GFP (top)
or HMP-2, a known HMP-1 binding protein (middle) in the IP, there is no detectable UNC-94 (bottom),
although there was abundant UNC-94 in the original extract (bottom, left). C. UNC-94 staining in the
pharynx. In wild-type elongation-stage embryos, 100% show staining for UNC-94 in the pharynx (n =
79). In hmp-1(zu278) embryos, 86% have UNC-94 staining in the pharynx (n = 87). In hmp-1(fe4)
embryos, 100% of elongating embryos show staining for UNC-94 in the pharynx (n = 63). Bar = 10 µm.
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Figure S2. Junctional-Proximal Actin and Circumferential Filament Bundles (CFBs) Are
Perturbed in unc-94 Loss-of-Function Embryos
Phalloidin staining of actin in ~1.5-fold embryos. Phenotypic defects were categorized into three
classes. (A) In Class I embryos (wild-type embryo shown), there is a clear thin band of actin at the
junction (white arrowhead), evenly spaced CFBs, and a dense meshwork of actin in seam cells. (B)
In Class II embryos (unc-94(tm724) embryo shown), there are clumps of CFBs (arrow), but the
overall amount of actin in the embryo is not decreased. Muscle organization is also perturbed (yellow
arrowhead). (C) In Class III embryos (unc-94(RNAi) embryo shown), there is clumping of junctional
actin and often a substantial decrease in the amount of actin present in seam cells (not visible in this
example). As in Class II embryos, muscle organization is perturbed (yellow arrowhead). (D)
Distribution of phenotypes for the three genotypes of embryos screened (wildtype, n=13; unc94(RNAi), n=19; unc-94(tm724) n=11). For all images, anterior is to the left; bar=10µm. * =
significantly different, p < 0.05. unc-94(RNAi) and unc-94(tm724) are not significantly different (p =
0.32).
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Figure S3. The Adherens Junctions of hmp-1(fe4);unc-94(RNAi) Embryos Exhibit Abnormal
Dynamics in Living Embryos
JAC-1::GFP localization was assessed in living embryos using spinning disc confocal microscopy.
(A, B) unc-94 loss-of-function results in slightly perturbed adherens junctions. (A) unc-94(RNAi)
embryo. Regions of JAC-1::GFP mislocalization (arrow), were observed in 3 out of 23 embryos
examined. (B) unc-94(tm724) embryo. (C) hmp-1(zu278) embryo. In 6 out of 6 embryos observed
(at the 1.25-1.5 fold stage), the seam:ventral/seam:dorsal borders exhibited dislocation of JAC1::GFP reminiscent of, but not quite as dynamic as, that seen in hmp-1(fe4);unc-94(RNAi) embryos.
(D, E) let-502(RNAi) ameliorates the junctional dislocation in hmp-1(fe4);unc-94(RNAi) embryos.
(D) Arrested hmp-1(fe4);unc-94(RNAi) embryo showing dislocated JAC-1::GFP. (E) Arrested hmp1(fe4);unc-94, let-502(RNAi) embryo. Some regions in C and D are slightly out of focus due to the
shape of the embryos and movement due to muscle twitching. Bar = 10 µm.
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Figure S4. Tissue-Specific Requirements for HMP-1 and UNC-94 Function and Effects of LET502/ROCK on Junctional-Proximal Actin
A. Tissue-specific rescue of defects in hmp-1(fe4);unc-94(RNAi) embryos indicates a major
requirement for HMP-1 and UNC-94 in non-seam epidermal cells. hmp-1(fe4) hermaphrodites
expressing Pnhr-73::hmp-1::gfp (expressed in seam cells) or Pelt-3::hmp-1::gfp (expressed in nonseam cells) were subjected to unc-94(RNAi) via feeding or fed control bacteria (L4440), and progeny
scored for developmental arrest. ** = significantly different, p < 0.001. B. Loss of let-502/Rho kinase
function leads to shorter cells with thicker UNC-94-positive junctional proximal actin bands. let502(sb118) embryos were temperature-shifted as described in Experimental Procedures and
immunostained for AJM-1(to determine overall cell shape) and UNC-94. The thickness of the UNC-94containing junctional proximal band was measured as shown and plotted against length/width ratio for
let-502(sb118) and wild-type embryos. A power curve was used to fit the resulting data.
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Supplemental Experimental Procedures
Strains and Alleles
The Bristol N2 strain was used as wildtype. hmp-1(fe4) [1] was maintained as a heterozygote over
lon-3(e2175) as a marker for the wild-type chromosome. The previously described jac-1::gfp
transgene [1] was integrated via gamma irradiation (jcIs24), outcrossed six times, and homozygosed
to generate the strain SU295. Crosses were performed to introduce jcIs24 into hmp-1(fe4)/lon3(e2175) and into unc-94(tm724). unc-94(tm724) was obtained from Shohei Mitani (National
Bioresource Project for C. elegans, Tokyo Women’s Medical University School of Medicine, Tokyo,
Japan). The unc-94(tm724) allele has a 695 base pair deletion and 17 bp insertion that might result in
a frame shift after the third exon.
A strain (ML753) expressing a gfp-tagged fragment of vab-10 that binds F-actin in epidermal
cells (VAB-10(ABD):GFP [2]) was mated with unc-94(tm724) or hmp-1(fe4) males and the relevant
mutation was rehomozygosed to create strains used in spinning disc confocal filming experiments.
HR1157 carries a let-502 temperature sensitive allele (sb118) that was kindly provided by Paul
Mains (University of Calgary).
Tissue-specific HMP-1 rescuing constructs were made using Fusion PCR [3]. The nhr-73
promoter was used for seam-specific expression and the elt-3 promoter was used for non-seam
epidermal expression. Phusion Polymerase (NEB) was used to PCR amplify ~1kb of the nhr-73
promoter (5' CTTGAGCAACAATTTTCAGAGCAGTGGAGGTTTTGT3' forward and
3'CCATTCGCAGGCAT TCTGAAAATTAATTTTTCTTCAAACTTGCC5' reverse, with 25bp
overhang for hmp-1) or ~2kb of the elt-3 promoter (5'
ACCGAAATGCCGATGGACATATCAAATGTGAAGACA3' and
3'CATGAGAATTGCCATTCGCAGGCATGAAGTTTGAAATACCAGGTAGCCGA5' reverse,
with 25bp overhang for hmp-1) from C. elegans genomic DNA. hmp-1::gfp was PCR amplified using
Phusion Polymerase with pJS434 [4] as a template (5' TAATTTTCAGAATGCCTGCGAATGG3'
forward and 3' GCATAGTTAAGCCAGCCCCGACACC5' reverse) for fusion to Pnhr-73 or
5'ATGTGTCAGAGGTTTTCACCGTCAT3' forward and
3'ATGTGTCAGAGGTTTTCACCGTCAT5' reverse for fusion to Pelt-3). Fusion PCR was
performed to connect these two nested PCR products using Go Taq Long (for Pnhr-73::hmp-1::gfp:
5'TATGTGTCAGAGGTTTTCACCGTCAT3' and 3'ATGTGTCAGAGGTTTTCACCGTCAT5'; for
Pelt-3::hmp-1::gfp: 5'GTTTCTACTGTTTCAACATTATGTGTCAGAGGTTTTCACCGTCAT3' and
3'ATGTGTCAGAGGTTTTCACCGTCAT5').
Fusion PCR constructs (Pelt-3::hmp-1::gfp and Pnhr73::hmp-1::gfp) were injected into hmp-1(fe4)
worms. At least two reactions were pooled for injection to minimize the chance of proofreading
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errors. About 80ng of the Fusion reactions were co-injected with Pttx-3::dsRed into the gonads of hmp1(fe4) worms. Expression of the HMP-1::GFP constructs in either seam or non-seam cells was
verified with confocal microscopy.

Antibodies
A polyclonal rabbit anti-UNC-94 antibody was produced and affinity purified by the Proteintech
Group, Inc. (Chicago, IL) using amino acids 144-401 of UNC-94b as the antigen as previously
described [5]. Rabbit anti-HMR-1 antibody was generously provided by J. Priess (Fred Hutchinson
Cancer Research Center, Seattle, WA). MH27 antibodies were purified from ascites fluid (Harlan
Sprague Dawley, Madison, WI) from hybridoma cells obtained from the Developmental Hybridoma
Bank (Univ. of Iowa). A monoclonal anti-actin antibody (C4, MP Biomedicals, Irvine CA) was used
for Western blotting.

Feeding RNAi Screening
The C. elegans Chromosome I feeding RNAi library in 96 well format was used for screening [6].
This library contains 2,445 bacterial cultures (HT115 (DE3) strain) each expressing a unique feeding
RNAi clone. A starter culture (LB with 25 µg/mL carbenicillin and 12.5 µg/mL tetracycline) was
inoculated with a replicator tool, using frozen material from the library plates, and grown overnight at
37oC. A second culture (LB + 25 µg/mL carbenicillin) was inoculated using material from the starter
plate and cultured overnight at 37oC. 10 µL of this culture was spread onto triplicate wells of 12 well
plates containing Nematode Growth Media [7] supplemented with 25 µg/mL carbenicillin and 1mM
isopropyl β-D-thiogalactopyranoside (IPTG). The bacteria were grown overnight to generate a thin
lawn.
Approximately 20-30 L3-L4 hmp-1(fe4) worms were seeded onto one well for each clone to be
tested. After allowing the worms to feed for 24 hours, 8 were singled onto each of the two remaining
wells for each clone. After another 24 hours, the worms were removed from the plates. Over the
next two days, the wells were visually scanned to determine the approximate percentage of embryonic
lethality. Feeding RNAi for wild type worms was performed in a similar manner except that 10-15
worms were seeded in the initial well and four were singled into the duplicate wells. In each round of
the screen, hmp-1(fe4) worms were fed the empty feeding vector, L4440[8], as a negative control and
a feeding vector for the known hmp-1(fe4) enhancer, unc-34 [9] as a positive control.
We identified 44 transcription units that, when depleted with feeding RNAi, enhanced the
lethality of hmp-1(fe4) to 95% or greater, and yielded less than 12% lethality in wild-type. A
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secondary screen was performed to confirm putative enhancers using a different source of doublestranded RNA (dsRNA) and RNAi by injection.

RNAi via Injection and Dead Embryo Counts
dsRNA was injected at 2 µg/µl into one gonad arm per worm, with the exception of let502(RNAi), which was injected at 1 µg/µl to avoid early arrest due to cytokinesis defects. To score
for embryonic and early larval lethality, worms were cultured for 12-16 hours after injection and then
singled onto new plates. The embryos produced over the next 24 hours were scored for lethality. To
obtain embryos for phenotypic analysis, worms were cut transversely through the vulva at 24 - 30
hours post-injection and extruded embryos were collected.
For tissue-specific rescue experiments, worms were selected for application to either empty vector
(L4440) or tmd-1 feeding RNAi plates based on the dsRed signal. Lethality was counted after 48 hours
of feeding. Chi-square analysis was performed using the online contingency table form available at
http://www.physics.csbsju.edu/stats/contingency.html.

Morphological Analysis and Embryo Staining
4D Nomarski microscopy was performed as described previously [10]. Phalloidin staining was
performed using a modification of a previously described protocol [11]. Briefly, embryos were
placed on poly-L-lysine coated slides, aged, treated with 1 mg/ml chitinase in egg salts for 20 min.,
and fixed with a solution of 4% paraformaldehyde, 0.1 mg/mL lysolecithin, 10 mM EGTA, 48 mM
PIPES (pH 6.8), 25 mM HEPES (pH 6.8) and 2 mM MgCl2. Embryos were stained with 1:20
Alexa555-phalloidin (Invitrogen Corp., Carlsbad, CA) overnight at 4oC. For immunostaining,
embryos were freeze cracked and stained as described [12] .
For immunocytochemistry experiments and live imaging of JAC-1::GFP and VAB10(ABD)::GFP, embryos were observed using a Perkin Elmer Ultraview spinning disk confocal
microscope and processed as described [9]. For videos of JAC-1::GFP, stacks of images (12-16
sections/stack) were taken at 10 sec intervals for 5 min; for VAB-10(ABD)::GFP, 10-30 focal planes
were captured at 30-120 sec intervals. Some images shown are projections of multiple focal planes.
Cells in elongating vab-10(ABD)::gfp embryos at the comma stage were scored as having
discontinuous actin bands if no discernible accumulation of actin could be identified over > 50% of
their ventral perimeter.
Actin defects in phalloidin stained specimens were scored as follows. Stained ~1.5-fold embryos
were categorized into three classes. In class I embryos a clear, thin band of actin at the junction and
evenly spaced circumferential filaments bundles (CFBs) were apparent, along with a dense meshwork
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of actin in seam cells. In class II embryos, clumps of CFBs were visible, but the overall amount of
actin in the embryo was not decreased. In class III embryos, clumping of junctional actin occurred,
and there was a substantial decrease in the amount of actin present in seam cells. Embryos were
categorized by three independent assessors and the results compiled. Chi-square analysis was
performed as above (see Procedures for tissue-specific rescue).
For measuring continuity of junctional proximal actin networks, a 5 pixel-wide freehand selection
was hand-traced along individual cell-cell junctions from maximum-intensity Z stack projections of
phalloidin stained specimens. The selection was then straightened using the “Edit->Selection>Straighten…” command in ImageJ. The signal was manually thresholded for each selection using
the “Image->Adjust->Threshold…” command to include all visible fluorescence along the
straightened cell-cell boundary. The number, size and total area of thresholded particles was then
calculated using the “Analyze->Analyze Particles…” command in ImageJ. Since the variances of the
wild-type and experimental groups failed the F test, pairwise heteroscedastic T-tests were performed
using Excel and StatPlus:mac (AnalystSoft). To construct box plots, standard box plot conventions
were used. The first (Q1) and third (Q3) quartiles, interquartile range (IQR = Q3 - Q1) and mean were
calculated. Extreme outliers were defined as lying beyond the outer fences OF1 = Q1 - 3 * IQR and
OF2 = Q3 + 3 * IQR. Mild outliers were defined as lying between OF1 and Q1- 1.5 * IQR or OF2
and Q3 + 1.5 * IQR. Box plots were constructed using StatPlus:mac.
For analysis of let-502(ts) embryos, worms carrying embryos were shifted to an intermediate,
restrictive temperature (25.5°C) and grown overnight. Embryos were recovered, stained via freezecracking [10] using MH27 and anti-UNC-94 antibodies and appropriate secondary antibodies (1:50
α-rabbit-FITC, 1:50 α-mouse-Texas Red), and imaged using spinning disc confocal microscopy. The
thickness of the junctional proximal actin at dorsal::seam boundaries was measured at several points
along the perimeter of individual cells using ImageJ (available at http://rsbweb.nih.gov/ij/), and an
average thickness was calculated for each cell measured. The length/width ratio of each cell was also
measured in ImageJ using the AJM-1 signal. The resulting actin band thickness vs. length/width data
were plotted in Excel and a curve fit was obtained using a power law.

Coimmunoprecipitation Assays
Embryos were collected from 10 large plates grown for 3-4 days at 20°C, homogenized in Lysis
buffer + 0.25% Triton X-100, subjected to centrifugation to clear the lysates, and precleared by
incubation on ice with 20µl of a 50% slurry of Protein G-Agarose beads essentially as described [13,
14]. To perform IPs, 5µl E36 mouse monoclonal anti-GFP (Invitrogen) was added to pre-cleared
lysate and rotated at 4°C for 1 hour, 40ul of 50% prepared Protein G-Agarose bead slurry (Pierce)
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was added, and rotated again at 4°C for 1 hour. Beads were sedimented at 3000 rpm for 3 min (4°C),
washed 3X with Lysis buffer, and 25ul 4x SDS-PAGE sample buffer was then added to preclear,
prewash, and IP bead fractions on ice. Collected samples were then subjected to SDS-PAGE on an
8% gel, along with 10 µl of Precision Plus Kaleidoscope Standard (Bio-Rad), and blotted onto PVDF
membrane. Blots were blocked using TBST + 5% non-fat dry milk, incubated in 1:2500 primary
(anti-UNC-94) antibody, washed in TBST, incubated in 1:10,000 anti-Rabbit HRP conjugate, and
visualized using enhanced chemiluminescence (ECL; Pierce) on X-ray film.

Expression and Purification of Recombinant UNC-94 Protein
A full-length unc-94b cDNA was cloned into plasmid pKLD37 using a vector provided by I.
Rayment (Dept. of Biochemistry, Univ. of Wisconsin), which consisted of pET31b with an N-term
6His-rTEV site. The Escherichia coli strain BL21 (DE3) was transformed with the expression vector
and cultured in M9ZB medium (Novagen, EMD Biosciences, Inc., San Diego, CA) containing 50
µg/ml ampicillin at 37 °C until A600 reached 0.6 cm-1. Protein expression was induced by adding 0.4
mM IPTG for 3 hours. The cells were harvested by centrifugation at 5,000 g for 10 minutes and
disrupted by a French Pressure cell at 360-580 kg/cm2 in a buffer containing 0.3 M NaCl, 50 mM
NaPO4, 10 mM imidazole, 1 mM phenylmethanesulfonyl fluoride, pH 7.4. The homogenates were
centrifuged at 20,000 g and the supernatants applied to a TALON cobalt affinity column (Clontech,
Mountain View, CA). Bound proteins were eluted with 0.3 M NaCl, 50 mM NaPO4, 100 mM
imidazole, pH 7.4. The fractions containing UNC-94 were dialyzed against 10 mM PIPES, 0.2 mM
dithiothreitol, pH 7.0 and purified further with a Mono-Q column (Amersham Biosciences, GE
Healthcare Bio-sciences, Corp., Piscataway, NJ) by elution with a linear NaCl gradient (0.1-0.5 M).
Fractions containing purified UNC-94 were dialyzed against F-buffer (0.1 M KCl, 2 mM MgCl2, 1
mM dithiothreitol, 20 mM Hepes-NaOH, pH 7.5). Concentrations of UNC-94 were determined by
densitometry of Coomassie blue-stained protein bands after SDS-PAGE using actin as a standard.

Actin Bundling Assays
Recombinant UNC-94 was expressed and purified as described above. GST-tagged HMP-1 was
produced using constructs previously described [4], purified on glutathione beads, eluted with 10 mM
glutathione, and cleaved with TEV protease in 50 mM Tris, pH 8 in solution. The digest was purified
using a Sephacryl S-300 column. Rabbit muscle G-actin (20% labeled with DyLight549) [15] was
polymerized in the presence of chicken CapZ [16] at a 100:1 molar ratio. Filaments were diluted to 5
µM actin with or without 5 µM HMP-1 and 2.5 µM UNC-94 and incubated for 15 min, mounted on
nitrocellulose-coated coverslips, and observed by epifluorescence using a Nikon TE2000 inverted
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microscope. The curvilinear lengths of resulting bundles were measured using the NeuronJ plugin for
ImageJ, available at http://rsbweb.nih.gov/ij/. Statistics were performed using Excel and
StatPlus:Mac.
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